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Disclaimer and Support

Disclaimer

GInaFiT and this manual come without ANY WARRANTY and are provided “AS-IS”. The software
GlnaFiT is copyrighted by the Katholieke Universiteit Leuven (KULeuven, Belgium). It is not
permitted to include GlnaFiT in any other application. The program is for research purposes only and
should not be solely relied upon for any reason.

Acknowledgements

On publishing/presenting the results obtained with GlnaFiT, you are kindly invited to refer to A.H.
Geeraerd, V.P. Valdramidis, J.F. Van Impe, 2005. GInaFiT, a freeware tool to assess non-log-linear
microbial survivor curves. International Journal of Food Microbiology, 102, 95-105 and to the original
research publications for the model(s) you selected for your case-study (as provided in the Excel result-
sheet(s) and this user manual).

Feedback

If you would have comments or suggestions regarding the installation, use or content of GlnaFiT, or if
you would be willing to provide a short user testimonial, please contact
annemie.geeraerd@biw.kuleuven.be, associate professor at www.mebios.be. Your comments and user
testimonials are highly appreciated.

Updates
Possible future updates will be accessible via the GlnaFit homepage http://www.qginafit.be/

Compatibility with different Microsoft® Office Excel ® versions

The GInaFiT version that you have obtained together with this manual is compatible with Microsoft®
Office Excel® 365, Microsoft® Office Excel® 2016, Microsoft® Office Excel® 2013, Microsoft®
Office Excel® 2010 and Microsoft® Office Excel® 2007, and in principle it should work for any
language (though we did obviously not test for every language). Installation instructions are provided
below.

Since Version 1.6 GlnaFiT is not compatible anymore with Microsoft® Office Excel® 2003,also called
Microsoft® Office Excel® XP. If you would be interested in receiving Version 1.5 (Version 1.7 contains
bug fixes not implemented in Version 1.5) for Microsoft® Office Excel® 2003/XP, please contact
annemie.geeraerd@biw.kuleuven.be.

Installation of GInaFiT Office
365/2016/2013/2010

For the installation instructions for GlnaFiT Office 2007, please refer to page 11 of this manual.

An essential requirement
Please carefully consider the following essential requirement before proceeding to the installation of
GlInaFiT in Office 365/2016/2013/2010: the MS-Excel Add-In “Solver” is installed.

This requirement can be verified by looking under the Excel worksheet tab “Data”. Solver should be
visible in the right corner, as indicated in the next figure.
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If the Solver is not appearing under the worksheet tab “Data”, it needs to be installed. This is to be
performed by following this procedure:
e Click the File tab.
Sl Ca
Home Insert Page Layout Formulas | Data | Review

BB E & BIr:
A_

From From From From Other Existing Refresh
Access Web  Text Sourcesv  Connections All~

Get External Data Connections
Al G £ |
A B | ¢ | b | E | F |

&2 Edit Links
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e The Microsoft Office Backstage view opens
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Home ’ Insert Page Layout Formulas Data Review Vit
| save
Save As
[ Open
[ Close

Recent Workbooks

Info

New
Print
Save & Send

Help

— |1 oOptions

B3 Exit

e Click Options;

e The Options dialog box appears. Select Add-Ins
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Excel Options.
General
S \_% View and manage Microsoft Office Add-ins.
Formulas
Proofing Add-ins
Save Name Location Type -
fanguage Active Application Add-ins
Ginafit C\Users\LeticiaH\Documents\GInaFiT.xla Excel Add-in
Advanced Oplosser-invoegtoepassing C\..€\0ffice14\Libran\SOLVER\SOLVER XLAM  Excel Add-in
Customize Ribbon Inactive Application Add-ins
Analysis ToolPak C\...\Offi 2XLL  Excel Add-in
lysis ToolPak - VBA C\..ffice14\Libranj\Analysis\ATPVBAEN.XLAM  Excel Add-in
chment C i ashx  Excel Add-in
om XML Data C:\.J\Microsoft Office\Officel4\OFFRHD.DLL  Document Inspector
) C.s\microsoft shared\Smart Tag\MOFLDLL  Action &
uro Currency Tools C:\...Office\Office14\Libran\EUROTOOLXLAM  Excel Add-in
Financial Symbol (XML) C\.s\microsoft shared\Smart Tag\MOFLDLL  Action
Headers and Footers C:\..J\Microsoft Office\Office14\OFFRHD.DLL  Document Inspector
Hidden Rows and Columns C:\..J\Microsoft Office\Officel\OFFRHD.DLL  Document Inspector
Hidden Worksheets C\.J\Microsoft Office\Office14\OFFRHD.DLL  Document Inspector
Invisible Content C\.J\Microsoft Office\Officel4\OFFRHD.DLL  Document Inspector
Microsoft Actions Pane 3 XML Expansion Pack
Document Related Add-ins
ment Related Add-ins £
Disabled Application Add-ins i

Add-in: Ginafit
Publisher:
< No available
Loaation:  C:\Users\LeticaH\Documents\GInaFiT.ua
Description:

Manage: | Excel Add-ins =]

o) o)

e At the bottom of the Add-Ins screen, select “Excel Add-Ins” under the drop-down list
next to “Manage”. It is likely (but not guaranteed) that “Excel Add-Ins” is already

appearing here. Then proceed by hitting the button Go

Excel Options
General "
i L% View and manage Microsoft Office Add-ins.
Formulas
Proofing Add-ins
Save Name ~ Location Type !
- Active Appiication Add-ins
Ginafit C:\Users\LeticiaH\Documents\GInaFiT.xla Excel Add-in
Advanced Oplosser-invoegtoepassing C:\..€\Officel4\Libran)\SOLVER\SOLVERXLAM  Excel Add-in
Customize Ribbon Inactive Application Add-ins
Analysis ToolPak C:\..\Officel4\Libran/\Analysis\ANALYS32.XLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA Ca\.ffice14\Libran)\Analysis\ATPVBAEN.XLAM  Excel Add-in
c ashx  Excel Add-in
[ Add-ans Custom XML Data C:\..)\Microsoft Office\Office14\OFFRHD.DLL  Document Inspector
Date (MY C:\.s\microsoft shared\Smart Tag\MOFLOLL  Action &
Thusticenter Euro Currency Tools C:\..Office\Office1 4\Libran/\EUROTOOLXLAM  Excel Add-in
Financial Symbol (XML) Ci\..s\microsoft shared\Smart Tag\MOFLDLL  Action
Headers and Footers C:\..J\Microsoft Office\Office14\OFFRHD.DLL  Document Inspector
Hidden Rows and Columns C:\..)\Microsoft Office\Office14\OFFRHD.DLL  Document Inspector
Hidden Worksheets C:\..J\Microsoft Office\Office1\OFFRHD.DLL  Document Inspector
Invisible Content \Microsoft Office\Officel\OFFRHD.DLL  Document Inspector,
Microsoft Actions Pane 3 XML Expansion Pack
Document Related Add-ins
ment Related Add-ins 3
Disabled Add-ins i
Add-in: Ginafit
Publisher:
< No available
Location: C:\Users\LeticiaH\Documents\GInaFiT.xia
Description:

Excel Add-ins

—p

| — |

Cancel
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e The item “Solver Add-in” has to be ticked in the list, i.e. the “v”’ should be visible before
the Solver Add-In. Alternatively, it may be the case that the Solver name is indicated with
its equivalent name in the language of your Windows version. If this is the case, select the
Solver with this other name.

add-tns I E.{

Add-Ins available:

D

I Analysis ToolPak =] | OK I
I~ analysis ToolPak - ¥BA
[~ Conditional Sum Wizard Cancel |
F Euro Currency Tools

Internet Assistant YEA
| Lookup Wizard &]
W Solver Add-in l

Automation, ..

<]

~Solver Add-in
Tool for optimization and equation solving

e Press OK
21
Add-Ins available:
| Analysis ToolPak a | oK I
[~ Analysis ToolPak - YBA

[~ Conditional Sum Wizard T
[~ Euro Currency Tools

[~ Internet Assistant YBA
[~ Lookup Wizard —’ﬁrowse...
Solver Add-in o l

f<|

~Solver Add-in
Tool for optimization and equation solving
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e The Solver should now be visible in the right corner under the Excel menu tab “Data”, as
indicated in the next figure.
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Installation of GInaFiT.xla
It is suggested to place the file GlnaFiT.xla in the directory
c:\Program Files\Microsoft Office\Officel4\ADDINS
or in a similar directory for an Office version in a language different from English.
Nevertheless, placing at any other location like, for example, C:\temp, is always possible.

Start MS-Excel with a blank work sheet.

e Click the File tab.

Data Review

Insert Formulas

Home Page Layout
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L@ _“ — —‘-l —JJ @ T Properties
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e The Microsoft Office Backstage view opens
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Home Insert Formulas Data Review

Page Layout

|l save
Save As

Recent Workbooks

[ Open

[ Close

Info
New
Print
Save & Send

Help

|1 Options

B3 Exit

e Click Options;

e The Options dialog box appears. Select Add-Ins

Excel Options.
General
View and manage Microsoft Office Add-ins.
Formulas
Proofing Add-ins
Save Name Location Type ja
Eangusge Active Application Add-ins
Ginafit C\Users\LeticiaH\Documents\GInaFiT.xla Excel Add-in
Advanced Oplosser-invoegtoepassing C:\...£\Office14\Libran/\SOLVER\SOLVERXLAM  Excel Add-in
Customize Ribbon Inactive Application Add-ins
Analysis ToolPak C\.e\Off 2XLL  Excel Add-in
g plysis ToolPak - VBA C:\.ffice14\Libran\Analysis\ATPVBAEN.XLAM  Excel Add-in
fachment c ashx  Excel Add-in
Add-Ins stom XML Data C:\..)\Microsoft Office\Office14\OFFRHD.DLL  Document Inspector
e (MY C:\.s\microsoft shared\Smart Tag\MOFLDLL  Action =
8 uro Currency Tools :\...Office\Office14\LibranAEUROTOOLXLAM  Excel Add-in
Financial Symbol (XML) .s\microsoft shared\Smart Tag\MOFLDLL  Action
Headers and Footers ..J\Microsoft Office\Office14\OFFRHD.DLL  Document Inspector
Hidden Rows and Columns \Microsoft Office\Officel4\OFFRHD.DLL  Document Inspector
Hidden Worksheets icrosoft Office\Office14\OFFRHD.DLL  Document Inspector
Invisible Content C\.J\Microsoft Office\Officel4\OFFRHD.DLL  Document Inspector
Microsoft Actions Pane 3 XML Expansion Pack
Disabled Application Add-ins ~

Add-in: Ginafit
Publisher:
C No available
Location: C:\Users\LeticiaH\Documents\GInaFiT.da
Description:

Manage: | Excel Add-ins =]

e At the bottom of the Add-Ins screen, select “Excel Add-Ins” under the drop-down list
next to “Manage”. It is likely (but not guaranteed) that “Excel Add-Ins” is already
appearing here. Then proceed by hitting the button Go.
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Headers and Footers
Hidden Rows and Columns
Hidden Worksheets

Excel Options
General =
1% View and manage Microsoft Office Add-ins.
Formulas
Proofing Add-ins
Save Name ~ Location Type -
Enigusge Active Application Add-ins
Ginafit C\Users\LeticiaH\Documents\GinaFiT xia Excel Add-in
Advariced Oplosser-invoegtoepassing C:\..6\Office14\Library\SOLVER\SOLVER.XLAM  Excel Add-in
Customize Ribbon Inactive Application Add-ins
Analysis ToolPak Office14\Libran\Analysis\ANALYS32.XLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA ice14\Library\Analysis\ATPVBAEN.XLAM Excel Add-in
r L hx  Excel Add-in
Add-Ins Custom XML Data \Microsoft Office\Officel\OFFRHD.DLL  Document Inspector
Date (XML) \microsoft shared\Smart Tag\MOFL.DLL Action g
Trust Center Euro Currency Tools ice\Office14\Library\EUROTOOLXLAM  Excel Add-in
Financial Symbol (XML) \microsoft shared\Smart Tag\MOFL.DLL Action

licrosoft Office\Office14\OFFRHD.DLL
licrosoft Office\Office14\OFFRHD.DLL
icrosoft Office\Office14\OFFRHD.DLL

Document Inspector
Document Inspector
Document Inspector

licrosoft Office\Office14\OFFRHD.DLL

Invisible Content
Microsoft Actions Pane 3

Document Inspector
XML Expansion Pack

Disabled Add-ins =
Add-in: Ginafit
Publisher:
< No available
Location: C:\Users\LeticiaH\Documents\GInaFiT.xia
Description:

ﬁ

F Manage: | Excel Add-ins

e In the Add-In screen tick the Add-In GlnaFiT when present in the list or select the
GlnaFiT.xla file by browsing to the directory selected at the start of this installation
procedure.

(¥] Browse
Add-Ins [ [t e
@Uv[ & » Leticia Haberbeck » Downloads 0ad: o
dd-Ins available: Organize »  New folder =- 0 @
alysis ToolPak <] E =
alysis ToolPak - VBA : (&) Microsoft Excel [~
J
43¢ Favorites
=
458, Downiouds GinaFiT
= % Recent Places
4 4 Libraries
) Documents
& Music
= Pictures
B Videos
Solver Add-n % Computer
Tool for optimization and equation solving i &
File name: ~ [Adduns -
o - Co)

e Press OK and please read carefully the two screens appearing.

e From this moment on the button GlnaFiT will be present in the Worksheet tab Add-
Ins (last tab)

=

v
“ Home Insert Page Layout Formulas Data Review View
ﬁ ‘* an Calibri Y1 AN S Wrap Text
e . B~ A~ :
- < Format Painter I U =] £ Merge & Cente
Clipboard | Font I Alignment
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Home Insert Page Layout Formulas Data Review View } Add-Ins 1
GlnaFiT~| < — | -

Bigelow and Esty, 1920: Log-Linear Regression

Geeraerd et al., 2000: Log-Linear = Shoulder
-E Geeraerd et al., 2000: Log-Linear = Tail
= Geeraerd et al,, 2000: Log-Linear = Shoulder =+ Tail
L Mafart et al., 2002: Weibull ] i I G I H I ! I
= Mafart et al.,, 2002: Weibull, Fixed p-parameter
3 Albert and Mafart, 2005: Weibull = Tail
_‘ Corroler et al., 2006: Double Weibull
: Cerf, 1977: Biphasic Model
| Geeraerd et al,, 2005: Biphasic = Shoulder
e Disclaimer & Bibliographic reference
i About GInaFiT
How to remove GInaFiT
Start MS-Excel with a blank work sheet.

e Click the File tab.

H; Ir\sert Page Layout Formulas Data | Review

D " TEN =™ Tes 5| Connections
B2 B & B2 z
3 Properties
From From From From Other Existing Refresh lZ\

Access Web Text Sources~  Connections | Allx =2 EditLinks
Get External Data Connections
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A B | ¢ [ o | e [ ¥ [ u
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e The Microsoft Office Backstage view opens
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e Click Options;

Insert Page Layout

Formulas Data

Review Vit

|l save
Save As
[ Open
[ Close

Info

Recent Workbooks

New
Print
Save & Send

Help

B3 Exit

e The Options dialog box appears. Select Add-Ins

Trust Center

Attachment

Custom XML Data

Date (XML}

Euro Currency Tools
Financial Symbol (XML)
Headers and Footers
Hidden Rows and Columns
Hidden Worksheets
Invisible Content
Microsoft Actions Pane 3

Document Related Add-ins

No Document Reiated Add-ins

Disabled Application Add-ins

Excel Options
General [ o : ; :
s _&) View and manage Microsoft Office Add-ins.
Formulas
Proofing Add-ins
Save Name Location Type &
Language Active Application Add-ins
Ginafit C:\Users\LeticiaH\Documents\GInaFiT.xla Excel Add-in
Advanced Oplosser-invoegtoepassing C\...e\Office14\Library\SOLVER\SOLVER XLAM  Excel Add-in
Customize Ribbon Inactive Application Add-ins
Analysis ToolPak C\...e\Officel4\Library\Analysis\ANALYS32.XLL  Excel Add-in
Analysis ToolPak - VBA icel4\Library\Analysis\ATPVBAEN.XLAM Excel Add-in

\Microsoft Office\Office14\OFFRHD.DLL
\microsoft shared\Smart Tag\MOFL.DLL

Office\Office14\Libran\EUROTOOL.XLAM
\microsoft shared\Smart Tag\MOFL.DLL

Microsoft Office\Officel4\OFFRHD.DLL
Microsoft Office\Officel4\OFFRHD.DLL
Microsoft Office\Officel4\OFFRHD.DLL
C\..)\Microsoft Office\Officel4\OFFRHD.DLL

Users\LeticiaH\Documents\attachment.ashx  Excel Add-in

Document Inspector
Action

Excel Add-in

Action

Document Inspector
Document Inspector
Document Inspector
Document Inspector
XML Expansion Pack

available

Add-in: Ginafit

Publisher:

Cy ibilif No ¢

Location: C:\Users\LeticiaH\Documents\GInaFiT.xla

Description:

=] gon ]

e At the bottom of the Add-Ins screen, select “Excel Add-Ins” under the drop-down list next
to “manage”. It is likely (but not guaranteed) that “Excel Add-Ins” is already appearing
here. Then proceed by hitting the button Go

GlnaFiT - Version 1.7
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.
Excel Options

Headers and Footers
Hidden Rows and Columns
Hidden Worksheets
Invisible Content
Microsoft Actions Pane 3

Document Related Add-ins

No Document Related Add-ins

Disabled Application Add-ins

General ,3 : : ; :
s |i=y View and manage Microsoft Office Add-ins.
Formulas
Proofing Add-ins
Save Name ~ Location Type [
Language Active Application Add-ins
Ginafit C:\Users\LeticiaH\Documents\GInaFiT.xla Excel Add-in
Advanced Oplosser-invoegtoepassing C:\...e\Officel4\Libran/\SOLVER\SOLVER.XLAM  Excel Add-in
Customize Ribbon Inactive Application Add-ins
Analysis ToolPak C\...e\Officel4\Librany\Analysis\ANALYS32.XLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA C\...fficeld\Librany\Analysis\ATPVBAEN. XLAM Excel Add-in
Af C:\Users\LeticiaH\Documents\attachment.ashx  Excel Add-in
Add-Ins Custom XML Data C\..)\Microsoft Office\Office14\OFFRHD.DLL Document Inspector
Date (XML} C\...s\microsoft shared\Smart Tag\MOFL.DLL Action =
TrustGenter Euro Currency Tools C:\...Office\Office14\Library\EUROTOOLXLAM  Excel Add-in
Financial Symbol (XML) C\..s\microsoft shared\Smart Tag\MOFL.DLL Action

C\..)\Microsoft Office\Office14\OFFRHD.DLL Document Inspector
C\..)\Microsoft Office\Officel4\OFFRHD.DLL
C\...)\Microsoft Office\Office14\OFFRHD.DLL

C\..)\Microsoft Office\Office14\OFFRHD.DLL

Document Inspector
Document Inspector
Document Inspector
XML Expansion Pack

Add-in: Ginafit
Publisher:

Compatibility: No compatibility information available

Location: C\Users\LeticiaH\Documents\GInaFiT.xla
Description:
ﬁ Manage: | Excel Add-ins ] :I I

In the Add-In screen untick the Add-In GlnaFiT.
A screen appears, press OK on that screen.

procedure.

Delete the GlnaFiT.xla file from the directory selected at the start of the installation

Installation of GInaFit Office 2007

An essential requirement

Please carefully consider the following essential requirement before proceeding to the installation of
GlnaFiT Office 2007: the MS-Excel Add-In “Solver” is installed.

This requirement can be verified by looking under the Excel worksheet tab “Data”. Solver should be
visible in the right corner, as indicated in the next figure.
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If the Solver is not appearing under the worksheet tab “Data”, it needs to be installed. This is to be
performed with the procedure
e Hit the Office Button (this is the Circle with the Office logo in the upper left corner of
the Excel application)
e Hit the button “Excel Options”

@ FEEERETEDNE

Recent Documents |
MNew
=

1 case-study_Ecoli_566.xls

=
7/ Qpen

Conyert

5
d
B soess
3
7
=

|,_} Excel Options | | X Exit Excel

e Select Add-Ins

Excel Options @
Papular "

™
_‘g Change the most popular options in Excel.

Formulas |
Proofing Top options for working with Excel |
Save Show Mini Toolbar on selection (i
Enable Live Preview (7
Advanced
[ show Developer tab in the Ribbon G
Customize Always use ClearType
Color scheme: | Blue |
Trust Center ScreenTip style: | Show feature descriptions in ScreenTips v
Hessiirees \ Create lists for use in sorts and fill sequences: | Edit Custom Lists...

‘When creating new workbooks

Use this font: [Body Font =
Font size: 11 ¥]

Default view for new shests: | Normal View I

Include this many sheets: 3 3| o

Personalize your copy of Microsoft Office

Username: | AnnemieG

Choose the languages you want to use with Microsoft Office: | Language Settings...

e At the bottom of the Add-Ins screen, select “Excel Add-Ins” under the drop-down list
next to “manage”. It is likely (but not guaranteed) that “Excel Add-Ins” is already
appearing here. Then proceed by hitting the button Go.
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Excel Options

Popular M. ) -
L d}?ﬁ View and manage Microsoft Office add-ins.
Formulas
Proofing Add-ins
Save Name Location Type o
Advanced m ”
Customize

| Add-Ins I Analysis ToolPak

Analysis ToolPak - VBA

Trust Center Custom XML Data

Euro Currengy Tools

Financial Symbol (Smart tag lists)
Headers and Footers

Hidden Rows and Columns
Hidden Worksheets

Internet Assistant VBA

Invisible Content

Person Name (Qutlook e-mail recipients}
fizard Opzoeken

Wizard Voorwaardelijke som

ce\Office12\Librany\Analysis\ANALYS32.XLL  Excel Add-in
tfice12\Library\Analysis\ATPVBAENXLAM  Excel Add-in
es\Microsoft Office\Office1 210FFRHD.DLL  Document Inspector
Office\Office1 2\Library\EUROTOOLXLAM  Excel Add-in
.iles\Microsoft Shared\Smart Tag\MOFLDLL ~ Smart Tag
.iles\Microsoft Office\Office12\OFFRHD.DLL  Document Inspector
\iles\Microsoft Office\Office12\OFFRHD.DLL  Document Inspector
.iles\Microsoft Office\Office12\OFFRHD.DLL  Document Inspector
.icrosoft Office\Officel 2\Libran\HTMLXLAM  Excel Add-in
:\.wiles\Microsoft Office\Office12\OFFRHD.DLL  Document Inspector
..es\Microsoft Shared\Smart Tag\FNAME.DLL ~ Smart Tag

:\...50ft Office\Office1 2\Libran/\LOOKUP.XLAM  Excel Add-in
..rosoft Office\Office12\Libran/\SUMIF XLAM  Excel Add-in

Resources

aonoononnn

Add-in: Analysis ToolPak
Publisher: Microsoft Corporation
Location: C:\Program Files\Microsoft Office\Office12\Library\Analysis\ANALYS32.XLL

D ion:  Bevat hulpp! ‘s voor het van stati en technische gegevens

Manage: | Excel Add-ins

+——

e The item “Solver Add-in” has to be ticked in the list, i.e. the “v” should be visible before
the Solver Add-In. Alternatively, it may be the case that the Solver name is indicated with
its equivalent name in the language of your Windows version. If this is the case, select the
Solver with this other name.

add-ins IR

Add-Ins available:

| Analysis ToolPak _.J K
I~ analysis ToolPak - YBA
I~ Conditional Sum Wizard Cancel
I~ Euro Currency Tools
I Internet Assistant YBA
| Lookup Wizard
S r &dd-in

Browse...

Automation. ..

Ik

f.a|

~Solver Add-in
Tool for optimization and equation solving

e Press OK
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21
Add-Ins available:

| Analysis ToolPak - | OK I
[~ Analysis ToolPak - YBA

[~ Conditional Sum Wizard

ancel
[~ Euro Currency Tools
[~ Internet Assistant YBA
Browse..,
[~ Lookup Wizard =

Solver Add-in

Automation, ..

I

~Solver Add-in

Tool for optimization and equation solving

e The Solver should now be visible in the right corner under the Excel menu tab “Data”, as
indicated in the next figure.

A L e
\ e
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Installation of GInaFiT.xla
It is suggested to place the file GlnaFiT.xla in the directory
c:\Program Files\Microsoft Office\Officel12\ADDINS
or in a similar directory for an Office version in a language different from English.

Nevertheless, placing at any other location like, for example, C:\temp, is always possible.

Start MS-Excel with a blank work sheet.

¢ Hit the Office Button (this is the Circle with the Office logo in the upper left corner of
the Excel application)

e Hit the button “Excel Options”
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@ H9- o ([@ERE) -
v

Recent Documents
HNew
1 case-study_Ecali_566.xls = |
~
J DOpen
= —
".“.!: Conyert
LG
bl =
E Save As b
@ Print L3
5% Prepare  »
@ Send 3
EEE} Publish  »

J LClose

[ 3 Excel Options | [ X Exit Excel ||

U

'y
e Select Add-Ins

Excel Options i E

- s
- popuiar ] w‘a Change the most popular options in Excel.

Formulas
Proofing Top options for working with Excel
Save Show Mini Toolbar on selection (i
. Enable Live Preview
Advanced _
[] Show Developer tab in the Ribbon G
Customize Always use ClearType
Add-Ins Color scheme: | Blue v
Trust Center ScreenTip style: | Show feature descriptions in ScreenTips v|
Hastiineas \ Create lists for use in sorts and fill sequences: | Edit Custom Lists...

When creating new workbooks

Use this font: [Body Fant v

Font size: [11 [+
Default view for new sheats: | Normal View v \
Include this many sheets: 3 =

Personalize your copy of Microsoft Office

Username: |[AnnemieG |

Choose the languages you want to use with Microsoft Office: Language Settings...

e At the bottom of the Add-Ins screen, select “Excel Add-Ins” under the drop-down list
next to “manage”. It is likely (but not guaranteed) that “Excel Add-Ins” is already
appearing here. Then proceed by hitting the button Go.
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Excel

Popular
Formulas
Proofing
Save
Advanced
Customize

| Add-Ins |
Trust Center

Resources

_&) View and manage Microsoft Office add-ins.

Add-ins

Name

Analysis ToolPak

Analysis ToolPak - VBA

Custom XML Data

Euro Currengy Tools

Financial Symbol (Smart tag lists)
Headers and Footers

Hidden Rows and Columns
Hidden Worksheets

Internet Assistant VBA

Invisible Content

Person Name (Qutlook e-mail recipients}
fizard Opzoeken

Wizard Voorwaardelijke som

Location

&\Officel 2\Library\Analysis\ANALYS32.XLL
fficel2\Library\Analysis\ATPVBAEN. 1
.iles\Microsoft Office\Office12\OFFRHD.DLL
ft Office\Office12\Libran\ EURCTOOL.XLAM
iles\Microsoft Shared\Smart Tag\MOFL.DLL
s\Microsoft Office\Office12\OFFRHD.DLL
s\Microsoft Office\Office12\OFFRHD.DLL
s\Microsoft Office\Office1 2\OFFRHD.DLL
rosoft Office\Officel2\Libran/\HTML.XLAM
's\Microsoft Office\Office12\OFFRHD.DLL
Microsoft Shared\Smart Tag\FNAME.DLL
ft Office'\Office12\Librany\LOOKUP.XLAM
«rosoft Office\Office1 2\Library\ SUMIF XLAM

nnoonnon00NON

Type

Excel Add-in

Excel Add-in
Document Inspector
Excel Add-in

Smart Tag
Document Inspector
Document Inspector
Document Inspector
Excel Add-in
Document Inspector
Smart Tag

Excel Add-in

Excel Add-in

Add-in: Analysis ToolPak

Publisher  Microsoft Corporation

Location:  C:\Program Files\Microsoft Office\Office1 2\Library\Analysis\ANALYS32.XLL

D Bevat hulpp s voor het van en technische gegevens
Manage: | Excel Add-ins ‘—

In the Add-In screen tick the Add-In GlnaFiT when present in the list or select the
GlnaFiT.xla file by browsing to the directory selected at the start of this installation

procedure.

Add-Ins

Add-Ins available:

Laok in:

I Analysis ToolPak

[ Analysis ToolPak - YBA
[ Conditional Sum Wizard
| Drools32

I Euro Currency Tools

ol Ginafit

L’g}

afit
| Internet Assistant YBA
[ Lookup Wizard

I Risk

v Salver Add-in

Ginafit

2| oK
Cancel
Browse. ..
Aukomation. ..

History

My Documents

=

Desktop

&

Favarites

[ test sl e-mEm & K0 E - Tods-

[Betnar =

File name: |

=]
[=|

Files of tvpei  [add-Ins (*.sda; *.xl) Cancel

Press OK and please read carefully the two screens appearing.
From this moment on the button GInaFiT will be present in the Worksheet tab Add-

Ins (last tab)
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Home Insert Page Layout Farmulas Data Reviey

GInaFiT =

Bigelow and Esty, 1920: Log-Linear Regression

Geeraerd et al., 2000: Log-Linear = Shoulder
BIETIE Geeraerd et al,, 2000: Log-Linear = Tail

A Geeraerd et al., 2000: Log-Linear = Shoulder = Tail

A Mafart et al., 2002: Weibull |
1 [Data W\ - )
2 Mafart et al,, 2002: Weibull, Eixed p-parameter
3 0. Albert and Mafart, 2005: Weibull = Tail
- 1. Carraler et al,, 2006: Double Weibull
5 2,
6 3 Cerf, 1977: Eiphasic Model
T g Geeraerd et al,, 2005 Biphasic = Shoulder
g i Disclaimer & Bibliographic reference
9 9.
10 12 About GInaFiT
11 14.00 7.92
12 16.00 7.18

How to remove GInaFiT

Start MS-Excel with a blank work sheet.

o Hit the Office Button (this is the Circle with the Office logo in the upper left corner of

the Excel application)
e Hit the button “Excel Options”

@ H9- ¢ [@@E) -
v

Recent Documents
Mew
w ||

1 case-study_Ecoli_5&6.xls

~
7 pen

= —
5 !: Conyert
el

Save As b
Print 3
Prepare  F

Send 3

& Ndp Z

EE}: Publish  »

J“ Close

[ Excel Options || X Exit Excel ||
Uy v y y ' Y
21

e Select Add-Ins
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Excel

| Papular il R —
l o ] 1_@ Change the most popular options in Excel.
Formulas
Proofing Top options for working with Excel
Save Show Mini Toolbar on selection (;
" Enable Live Preview
Advanced
| [ Show Developer tab in the Ribbon G
Customize Always use ClearType
Color scheme: | Blue %
Trost Genter ScreenTip style: | Show feature descriptions in ScreenTips v|
Hestiivdes V\ Create lists for use in sorts and fill sequences: | Edit Custom Lists...

‘When creating new workbooks

Use this font: Body Font v

Font size: [11 %]
Default view for new sheets: | Normal View v \
Include this many sheets: |3 $

Personalize your copy of Microsoft Office

Username: |AnnemieG |

Choose the languages you want to use with Microsoft Office: | Language Settings...

e At the bottom of the Add-Ins screen, select “Excel Add-Ins” under the drop-down list
next to “manage”. It is likely (but not guaranteed) that “Excel Add-Ins” is already
appearing here. Then proceed by hitting the button Go

Excel Options E

Popular - N X -
F View and manage Microsoft Office add-ins.
Formulas
Proofing Add-ins
Save Name Location Type »
Advanced Ariies: Appical
Customize i
| Add-Ins N Analysis ToolPak Ci\.. fice\Office1 2\Libran/\Analysis\ANALYS32.XLL  Excel Add-in
Analysis ToolPak - VBA C:\...\Office12\Librany\Analysis\ATPVBAEN.XLAM  Excel Add-in
Trust Center Custom XML Data Cil..iles\Microsoft Office\Office12\OFFRHD.DLL  Document Inspector
Euro Currency Tools C:\..ft Office\Office1 2\Library\EUROTOOLXLAM  Excel Add-in
Resources Financial Symbol (Smart tag lists) Cil..iles\Microsoft Shared\Smart Tag\MOFLDLL ~ Smart Tag
Headers and Footers Ci\..iles\Microsoft Office\Office12\OFFRHD.DLL  Document Inspector
Hidden Rows and Columns Ci\..iles\Microsoft Office\Office12.0FFRHD.DLL  Document Inspector
Hidden Worksheets Ci\..iles\Microsoft Office\Office12\OFFRHD.DLL  Document Inspector
Internet Assistant VBA Ci\.icrosoft Office\OfficeL2\Libran\HTMLXLAM  Excel Add-in
Invisible Content Ci\..iles\Microsoft Office\Office12\OFFRHD.DLL  Document Inspector
Person Name (Outlook e-mail recipients) Ci\...es\Microsoft Shared\Smart Tag\ FNAME.DLL ~ Smart Tag
zard Opzoeken C:\...s0ft Office\Office1 2\Libran/\LOOKUP.XLAM  Excel Add-in
Wizard Voorwaardelijke som C:\..rosoft Office\Office1 2\Libran/\ SUMIF. XLAM  Excel Add-in
v
Add-in: Analysis ToolPak
Publisher:  Microsoft Corporation
Location:  C:\Program Files\Microsoft Office\Office12\Librany\Analysis\ANALYS32.XLL
D Bevat s voor het van en gegevens
Manage: | Excel Add-ins Go... e

e |nthe Add-In screen untick the Add-In GlnaFiT.

e Delete the GlnaFiT.xla file from the directory selected at the start of the installation
procedure.
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How to use GInaFiT

Select the data to be modelled in the Excel sheet. The first column should be time, the second column

should be LOG10(N).

A&~ T —_——

“ Home Insert

GInaFiT ~

Menu Commands

Page Layout

| A2 v A0
i | D

1 Time (h) LoglO!N!

= 0.00 9.58

3 1.00 9.66

e 2.00 9.45

| & 3.00 9.44

el 5.00 9.16

|7 7.00 9.28

il 9.00 9.24

9| 1200 8.30|

10|  14.00 7.92

11| 16.00 7.18

12| 19.00 6.03

13| 24.00 491

14| 26.00 4.27
15 28.00 3.28
16

Select the model to be applied out of the ten different models available as can be seen in the figure

below.
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5 T

MOme Insert Page Layout Formulas Data
GInaFiT -

Bigelow and Esty, 1920: Log-Linear Regression ‘
Geeraerd et al., 2000: Log-Linear = Shoulder
N
=t Geeraerd et al,, 2000: Log-Linear = Tail
= Geeraerd et al,, 2000: Log-Linear = Shoulder + Tail
Mafart et al,, 2002: Weibull L F
= Mafart et al,, 2002: Weibull, Fixed p-parameter
il Albert and Mafart, 2005: Weibull + Tail
=) Corroler et al,, 2006: Double Weibull
Cerf, 1977: Biphasic Model
| | Geeraerd et al., 2005: Biphasic = Shoulder
— Disclaimer & Bibliographic reference
™ About GInaFiT
10 14.00 7.92
11 16.00 7.18
12 19.00 6.03
13 24.00 4.91
14 26.00 4.27
15 28.00 3.28)
16|

3. A new sheet is inserted with the same name as the name of the original sheet followed by the hame
of the model selected, e.g., Sheetl would result in Sheetl Geeraerd Shoulder_Tail. The result is
demonstrated below.

Fa4)

Home  Insert  Pagelayout  Formulas  Data  Review  View | Adddns
GlnaFiT ~
L] —
AB40 Al - P
A B C D E E <) H 1 J K L M N o P Q R S 2 L
Measurea laenuriea
1 Time  LOG10(N) Squared Standard Error
2 0.00 9.58 9.47 0.01 Sl (Shoulder length) 8.61 0.54 Mean Sum of Squared Error  0.0303
3 1.00 9.66 9.47 0.04 kmax 071 0.02 Root Mean Sum of Squared Error 0.1741
4 2.00 9.45 9.47 0.00 LOG10(NO) 9.47 0.08 R-Square 0.9947
5 3.00 9.44 9.46 0.00 R-Square adjusted  0.9937
6 5.00 9.16 9.44 0.08 4D reduction is reached at  £21.84 units of time
7 7.00 9.28 9.35 0.01 Inactivation model identified
8 9.00 9.24 9.11 0.02 N=NO * exp(-kmax * t) * ( *s1))/(1 *51)-1) *exp( 1))
9 12.00 8.30 8.39 0.01 For identification purposes reformulated as
10 14.00 7.92 7.80 0.02 Log10(N) = Log10{NO) - kmax *t / Ln(10) + Log =sl)/(1+ *51) - 1) * Exp(-kmax * 1))
1n 16.00 718 7.19 0.00 as can be derived from
g2 19.00 6.03 6.25 0.05 AH. Geeraerd. C.H. Herremans and J.F. Van Impe 2000. Structural model requirements
13 24.00 491 4.72 0.04 to describe microbial inactivation during a mild heat treatment. Intemational Journal of
14 26.00 427 4.10 0.03 Food Microbiology. 59(3), 185-209
15 28.00 3.28 3.48 0.04
16 Least Sum of Squared Error 0.33
17
g8 1200
19
20
= 1000 "“"’T’\
22
23 800
24 o
2 g 600
)
26 3
27 400 4
28 *
2 200 +
30
31
2 000 .
5 | 0.00 5.00 1000 1500 2000 25.00 30.00
2 Time
= # Measured —identified
36
37
38
39
%]
R4» W] sheet1_Geeraerd_Shoulder Sheetl Sheet2 ”Sheet3 €3 K
Ready |

GInaFiT output when selecting the “Geeraerd et al., 2000: Log-Linear + Shoulder” Menu-Item
for the case-study at hand.
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A short advice on the use of GInaFiT

The tool is useful for testing ten different types of microbial survival models on user-specific
experimental data relating the evolution of the microbial population with time. The ten model types are:
(i) classical log-linear curves, (ii) curves displaying a so-called shoulder before a log-linear decrease is
apparent, (iii) curves displaying a so-called tail after a log-linear decrease, (iv) survival curves displaying
both shoulder and tailing behavior, (v) concave curves, (vi) convex curves, (vii) convex/concave curves
followed by tailing, (viii) biphasic inactivation kinetics, (ix) biphasic inactivation kinetics preceded by
a shoulder, and (x) curves with a double concave/convex shape. The models were originally published
as Bigelow and Esty (1920), Cerf (1977), Geeraerd et al. (2000), Mafart et al. (2002), Albert and Mafart
(2005), Geeraerd et al. (2005) and Coroller et al. (2006).

Next to the obtained parameter values, the following statistical measures are automatically reported:
standard errors of the parameter values, the Sum of Squared Errors, the (Root) Mean Sum of Squared
Errors, the R? and the adjusted R2. In addition, tsp, the time needed for a 4 log reduction of the initial
microbial population, as originally proposed by Buchanan et al. (1993), is also automatically reported
(for data sets covering at least 4 decimal reductions).

The tool can be used in two ways. On one hand, for end-users having already a qualitative idea of the
general shape of their survival curves, the choice for one of the model types is obvious. On the other
hand, if the end-user does not have a clear idea yet, two or more of the different model types available
can be tested and compared. The time for a 4 decimal reduction can be useful to summarize the
information present in a data set, for example, if a common survivor curve shape can not be selected for
a range of different conditions tested.

Additionally, the tool has some built-in features testing for mis-use, for example, when trying to identify
a model with tailing on data not having a tail or when using a too limited number of data points
(observations) in comparison with the number of parameters in the model type chosen (the number of
parameters ranges from 2 to 5 for the ten model types available).

Further illustration on the use of GlnaFiT can be found in Geeraerd et al. (2005). If the use or
interpretation of GlnaFiT results would raise questions, please contact us at
annemie.geeraerd@biw.kuleuven.be.
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